Trademarks

AJA, Xena, Io, and Kona are trademarks of AJA Video, Inc. All other trademarks are the property of their respective holders.

Notice

Copyright © 2004 AJA Video, Inc. All rights reserved. All information in this manual is subject to change without notice. No part of the document may be reproduced or transmitted in any form, or by any means, electronic or mechanical, including photocopying or recording, without the express written permission of AJA Inc.

FCC Emission Information

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense. Changes or modifications not expressly approved by AJA Video can effect emission compliance and could void the user's authority to operate this equipment.

Contacting Support

To contact AJA Video for sales or support, use any of the following methods:

443 Crown Point Circle, Grass Valley, CA. 95945 USA
Telephone: +1.800.251.4224 or +1.530.274.2048
Fax: +1.530.274.9442
Web: http://www.aja.com
Support Email: support@aja.com
Sales Email: sales@aja.com

When calling for support, have all information on the product (serial number etc.) at hand prior to calling.

Limited Warranty

AJA Video warrants that this product will be free from defects in materials and workmanship for a period of three years from the date of purchase. If a product proves to be defective during this warranty period, AJA Video, at its option, will either repair the defective product without charge for parts and labor, or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify AJA Video of the defect before the expiration of the warranty period and make suitable arrangements for the performance of service. The Customer shall be responsible for packaging and shipping the defective product to a designated service center nominated by AJA Video, with shipping charges prepaid. AJA Video shall pay for the return of the product to the Customer if the shipment is to a location within the country in which the AJA Video service center is located. Customer shall be responsible for paying all shipping charges, insurance, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or inadequate maintenance and care. AJA Video shall not be obligated to furnish service under this warranty a) to repair damage resulting from attempts by personnel other than AJA Video representatives to install, repair or service the product, b) to repair damage resulting from improper use or connection to incompatible equipment, c) to repair any damage or malfunction caused by the use of non-AJA Video parts or supplies, or d) to service a product that has been modified or integrated with other products when the effect of such a modification or integration increases the time or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY AJA VIDEO IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR IMPLIED. AJA VIDEO AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. AJA VIDEO’S RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE WHOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER AJA VIDEO OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
# Table Of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trademarks</td>
<td>ii</td>
</tr>
<tr>
<td>Notice</td>
<td>ii</td>
</tr>
<tr>
<td>FCC Emission Information</td>
<td>ii</td>
</tr>
<tr>
<td>Contacting Support</td>
<td>ii</td>
</tr>
<tr>
<td>Limited Warranty</td>
<td>ii</td>
</tr>
<tr>
<td>Table Of Contents</td>
<td>1</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Features</td>
<td>1</td>
</tr>
<tr>
<td>Windows Media Support</td>
<td>1</td>
</tr>
<tr>
<td>Microsoft applications</td>
<td>2</td>
</tr>
<tr>
<td>Other Applications</td>
<td>2</td>
</tr>
<tr>
<td>Requirements</td>
<td>2</td>
</tr>
<tr>
<td>Software</td>
<td>2</td>
</tr>
<tr>
<td>Application Requirements</td>
<td>3</td>
</tr>
<tr>
<td>Hardware</td>
<td>3</td>
</tr>
<tr>
<td>PCI Slot Information</td>
<td>3</td>
</tr>
<tr>
<td>XenaSD</td>
<td>3</td>
</tr>
<tr>
<td>XenaHD</td>
<td>4</td>
</tr>
<tr>
<td>XenaHD2</td>
<td>4</td>
</tr>
<tr>
<td>XenaSD2</td>
<td>4</td>
</tr>
<tr>
<td>Disk arrays and PCI performance for XenaSD</td>
<td>4</td>
</tr>
<tr>
<td>Disk arrays and PCI performance for XenaHD</td>
<td>4</td>
</tr>
<tr>
<td>Block Diagram</td>
<td>5</td>
</tr>
<tr>
<td>I/O Connections</td>
<td>6</td>
</tr>
<tr>
<td>AES/EBU Audio Inputs And Outputs (SD/HD only)—15-pin D-connector</td>
<td>7</td>
</tr>
<tr>
<td>Reference Input—BNC</td>
<td>7</td>
</tr>
<tr>
<td>SDI Input and Output—2 BNCs (SD/HD) or 4 BNCs (HD2/SD2)</td>
<td>7</td>
</tr>
<tr>
<td>Using Xena With Application Software</td>
<td>7</td>
</tr>
<tr>
<td>Control Panel</td>
<td>7</td>
</tr>
<tr>
<td>Video Settings—Choosing Format and Reference Source</td>
<td>7</td>
</tr>
<tr>
<td>Test Patterns</td>
<td>9</td>
</tr>
<tr>
<td>Capture</td>
<td>10</td>
</tr>
<tr>
<td>Windows Media Preferences—Set Dither</td>
<td>11</td>
</tr>
<tr>
<td>Windows Media Preferences—Set A/V Synchronization</td>
<td>11</td>
</tr>
<tr>
<td>Windows Media Preferences—Windows Media Player Preferences</td>
<td>12</td>
</tr>
<tr>
<td>Video Processing Settings</td>
<td>13</td>
</tr>
<tr>
<td>Using Xena With Adobe Photoshop</td>
<td>15</td>
</tr>
<tr>
<td>Import Plug-in</td>
<td>15</td>
</tr>
<tr>
<td>Export Plug-in</td>
<td>15</td>
</tr>
<tr>
<td>Using Xena With Adobe AfterEffects</td>
<td>16</td>
</tr>
<tr>
<td>Using Xena With PowerCG</td>
<td>16</td>
</tr>
<tr>
<td>Using Xena With ThumbsPlus</td>
<td>17</td>
</tr>
<tr>
<td>Working with ThumbsPlus</td>
<td>17</td>
</tr>
<tr>
<td>YUV Files and ThumbsPlus</td>
<td>17</td>
</tr>
<tr>
<td>Clipboard ‘image’ interface</td>
<td>17</td>
</tr>
</tbody>
</table>

*AJA Xena User Manual — Contents*
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipboard ‘filename’ interface</td>
<td>18</td>
</tr>
<tr>
<td>Supporting YUV Files within ThumbsPlus</td>
<td>19</td>
</tr>
<tr>
<td>Using the Photoshop Plug-in to Load YUV files</td>
<td>21</td>
</tr>
<tr>
<td>Using “copyname” as the Default Action</td>
<td>22</td>
</tr>
<tr>
<td>Reconciling Standard File Types With The “Edit” Default Action</td>
<td>22</td>
</tr>
<tr>
<td>Windows Media Audio Configuration</td>
<td>23</td>
</tr>
<tr>
<td>Sound Playback controls</td>
<td>24</td>
</tr>
<tr>
<td>Sound Recording controls</td>
<td>25</td>
</tr>
<tr>
<td>Windows Media Applications</td>
<td>27</td>
</tr>
<tr>
<td>Using Xena with Windows Media Encoder 9</td>
<td>27</td>
</tr>
<tr>
<td>Setup</td>
<td>27</td>
</tr>
<tr>
<td>For Best Encoder Performance</td>
<td>27</td>
</tr>
<tr>
<td>Encoder Configuration</td>
<td>28</td>
</tr>
<tr>
<td>Using Xena with Windows Media Player 9</td>
<td>28</td>
</tr>
<tr>
<td>Using Xena with GraphEdit</td>
<td>29</td>
</tr>
<tr>
<td>Using Xena with WMCap</td>
<td>29</td>
</tr>
<tr>
<td>Using Xena with Third-Party applications</td>
<td>30</td>
</tr>
<tr>
<td>Installation</td>
<td>31</td>
</tr>
<tr>
<td>Video and Audio Cabling</td>
<td>31</td>
</tr>
<tr>
<td>Video Specifications</td>
<td>32</td>
</tr>
<tr>
<td>Standard Definition converters</td>
<td>32</td>
</tr>
<tr>
<td>High Definition converters</td>
<td>32</td>
</tr>
<tr>
<td>AES Audio</td>
<td>32</td>
</tr>
<tr>
<td>Analog converters</td>
<td>32</td>
</tr>
<tr>
<td>Software Installation</td>
<td>32</td>
</tr>
<tr>
<td>About the Driver</td>
<td>33</td>
</tr>
<tr>
<td>Windows Plug-and-Play Driver Installation Procedure</td>
<td>33</td>
</tr>
<tr>
<td>Driver Upgrade Only</td>
<td>37</td>
</tr>
<tr>
<td>Xena Control Panel Installation</td>
<td>39</td>
</tr>
<tr>
<td>Xena Tools Installation</td>
<td>42</td>
</tr>
<tr>
<td>Install Photoshop Plug-ins</td>
<td>42</td>
</tr>
<tr>
<td>Install AfterEffects Plug-ins</td>
<td>42</td>
</tr>
<tr>
<td>Install PowerCG Support</td>
<td>42</td>
</tr>
<tr>
<td>WM99Capture Installation</td>
<td>42</td>
</tr>
<tr>
<td>DirectX9 Installation</td>
<td>42</td>
</tr>
<tr>
<td>Downloading and Installing Software From The AJA Website</td>
<td>43</td>
</tr>
<tr>
<td>Troubleshooting Installation Problems</td>
<td>43</td>
</tr>
<tr>
<td>Driver Has Not Loaded</td>
<td>43</td>
</tr>
<tr>
<td>PCI slot Compatibility</td>
<td>43</td>
</tr>
<tr>
<td>Page Table Entries</td>
<td>43</td>
</tr>
<tr>
<td>Green Lines (Xena Software Used With Kona Hardware)</td>
<td>44</td>
</tr>
<tr>
<td>Troubleshooting Software Operation</td>
<td>45</td>
</tr>
<tr>
<td>Firmware Initialization Failure</td>
<td>45</td>
</tr>
<tr>
<td>DMA Speed</td>
<td>45</td>
</tr>
<tr>
<td>Windows Media Problems and Solutions</td>
<td>45</td>
</tr>
<tr>
<td>When to Use the Reference Source Input</td>
<td>45</td>
</tr>
<tr>
<td>If Your Application Drops Frames</td>
<td>46</td>
</tr>
<tr>
<td>Specifications</td>
<td>46</td>
</tr>
</tbody>
</table>
Introduction

Xena provides high-speed uncompressed digital audio/video input/output in a simple to install Windows PCI card. Ideal for character generation, video stills, disk recording, and ultra-high quality webcasting, Xena offers Windows users a professional-quality solution for working with Windows media applications.

The Xena driver (available from www.aja.com/xena.htm) supplies a generic Windows Media interface for applications. Xena also supports PowerCG, ThumbsPlus, and Adobe Photoshop and After Effects.

Xena Models

The Xena series of PCI card modules for the Windows OS, consists of the following four products:

- XenaSD—offers one channel of Serial Digital video input and output
- XenaHD—offers one channel of High-definition Serial Digital video input and output
- XenaSD2—offers two channels of Serial Digital video input and output
- XenaHD2—offers two channels of High-definition Serial Digital video input and output

Installation and operation of all products is identical. Examples shown in this manual apply to all product manuals, although actual screens may have slight differences.

Features

- XenaHD boards support SMPTE 292M (SDI) digital video.
- XenaSD supports SMPTE 259M (SDI) digital video.
- XenaHD and XenaSD have one video input, one video output, and AES audio I/O (other configurations are available to OEM partners).
- XenaHD2 has two video inputs, two video outputs, and no audio capability.
- Xena boards support up to 6 channels of 24 Bit/48Khz AES Audio or Embedded Audio. The AES inputs support asynchronous audio at 32-96Khz.
- Xena drivers are DirectShow-compatible WDM Kernel Streaming drivers that work with Windows Media and most DirectShow applications.

Note: Xena software also runs on AJA Kona boards.

Windows Media Support

Most Windows media applications work properly with Xena as a capture device. However, since few applications support using Xena (or any other device) as an output device, the Xena Control Panel allows you to reconfigure the Windows Media Player to output video to the Xena card.

Six channels of audio are available from Xena, accessed as three stereo pairs:

- Channels one and two are represented as “Xena Audio Device (1).”
- Channels three and four are represented as “Xena Audio Device (2).”
- Channels five and six are represented as “Xena Audio Device (3).”

The Xena boards support DirectShow-compliant (Windows Media) applications. Microsoft's DirectX architecture uses DirectShow as the video component. Within this architecture, Xena's board driver is considered a “WDM Streaming” driver.
Under control of Windows Media applications, a WDM Streaming driver makes efficient use of system resources, as user-mode applications can command the driver. Other system components can process the video and audio streams entirely in kernel mode without the extra overhead of switching back and forth into user mode for processing.

Microsoft applications

Microsoft produces several Windows Media applications that support the Xena board, including:

- Windows Media Encoder
- WmCap
- Sound Recorder
- Windows Media Player

*Windows Media Encoder* is a great tool for producing streaming webcasts. When starting with pristine uncompressed video from the Xena board, Encoder can produce high quality images low-bandwidth networks. Encoder can also capture uncompressed video and audio to a .wmv file (for use on a high-speed disk system).

*WmCap* and *Sound Recorder* are simple tools useful for verifying Xena system set-up. Some of the more complex applications have many possible settings that can interfere with proper Xena usage. *WmCap* and *Sound Recorder* can also be useful in their own right; WmCap can save uncompressed video to an .avi file for viewing with Windows Media Player, or save compressed video for use with an encoding application such as Cleaner or Windows Media Encoder.

*Windows Media Player* can be configured to play video files through the Xena card’s SDI output. There is a configuration setting in the Xena Control Panel for Windows Media Player. When it’s chosen, the Windows registry is modified so that all Windows Media Player output goes to Xena instead of to the Media Player’s own video window.

**Note:** This configuration may interfere with preview capability in some video capture programs.

Other Applications

Xena boards also work great with many applications for character generation, producing stills, and general video work. Applications known to work, include Adobe Photoshop, Adobe After Effects, PowerCG, and ThumbsPlus.

Requirements

Software

- Windows XP or Windows 2000 with Service Pack 3 or better. (Windows XP is highly recommended for Windows Media applications.)
- DirectX 9 or 8.1 minimum. (DirectX 8.1 is included with Windows XP.) The latest DirectX Runtime is available at http://www.microsoft.com/windows/directx The DirectX 9.0c setup program can also be installed from the Xena CD.

**Note:** DirectX 8.1 may work for some applications. However, DirectX 9 is highly recommended for Windows Media applications.

- Administrator privileges are required for driver installation.

For Windows Media applications, the following requirements apply:

- Windows XP
- DirectX 9
• Windows Media Player 9 is required for the Windows Media Player application
• Windows Media Encoder 9 is required for Windows Media Encoder application

Application Requirements

• Photoshop 5.0 or above (for use with the supplied Photoshop plug-ins)
• Windows Media applications each have their own requirements for working with Xena. See the “Using Xena With Application Software” topic later in this manual for more information

Hardware

For detailed hardware requirements, see the Installation topic later in this manual.

• Minimum 400 Mhz Processor (Pentium III or better) and 128 Mbyte RAM
• 1GHz or faster Processor for real-time encoding with XenaSD using the Windows Media Encoder application.
• For recording uncompressed video, a high performance disk system will be required. Use the Xena disk system performance utility at “Start > Programs > AJA > Benchmarks > Test Disk Speed” to measure your system’s disk capabilities.
• Use the Xena PCI performance utility at “Start > Programs > AJA > Benchmarks > Test PCI performance with XenaSD” (or “with XenaHD”) to measure Xena’s DMA data transfer performance on your PCI bus. This will determine if your system’s performance is acceptable for use with Xena. Use the utility program to test the DMA transfer speed between the Xena card and the host PC’s memory. The benchmark utility program comes in SD and HD versions, and can be found under the Benchmarks folder on the Xena installation CD. PCI transfer speed is generally dependent on the speed of the computer’s Frontside Bus. For best transfer speeds, use a PC with the fastest Frontside Bus available.

Note: PCI slots that support “Zero Channel Raid” may prove problematic with a Xena installed. These tend to be green-colored slots on SuperMicro motherboards.

PCI Slot Information

The following information is not generally needed for Xena Users, but is provided for reference.

Bus Mastering must be enabled in the BIOS for the PCI slot where Xena is installed.

The PCI implementation for any particular PC determines how much memory is addressable by the CPU for each PCI slot. Some (rare) computers may have insufficient PCI addressing capabilities for some of the Xena boards. If the board is installed in a PCI slot with insufficient addressing capabilities, the computer may not boot with the Xena driver installed. You may need to contact the computer manufacturer to determine these limits. The amount of memory space required for each card is as follows:

• XenaHD and XenaHD2: 256M + 8K
• XenaSD2: 128M + 8K
• XenaSD: 128M + 4K

XenaSD

On XenaSD, a 64-bit PCI slot is recommended for real-time video functions. (These functions may work in a 32-bit slot, but there will be very little system overhead left.)

The XenaSD cards are designed for 5.0 volt signaling PCI slots, and will work in 32-bit or 64-bit PCI slots. However, this is dependent on the motherboard having both 5.0 Volt and 3.3 Volt power to the slot. Even though the PCI Specification requires that both voltages are supplied, some motherboard manufacturers may neglect to provide 3.3 volt power to a 5 volt PCI slot. The cards will not work in these slots.
The XenaSD card also works in a 3.3 Volt slot. However, in practice, motherboard manufacturers use 3.3 v signaling only for 66 MHz slots. The SD card will work in a 3.3 v, 66 MHz slot, but this reduces the speed of the entire 66 MHz bus to 33 MHz.

**XenaHD**

On XenaHD, a 64-bit PCI slot is required for real-time video functions.

The XenaHD cards are designed for 3.3 volt signaling PCI slots, and work in 32-bit or 64-bit PCI slots. However, this is dependent on the motherboard having both 5.0 Volt and 3.3 Volt power to the slot. Even though the PCI Specification requires that both voltages are supplied, some motherboard manufacturers may neglect to provide 5.0 v power to a 3.3 v PCI slot. The cards will not work in these slots.

The XenaHD card also works in a 5.0 v PCI slot of a modern computer bearing both 5.0 v and 3.3 v slots. Again, however, this is dependent on the motherboard supplying both 5.0 v and 3.3 v power to the slot. The cards will not work in an older system bearing only 5.0-volt slots. (If the motherboard has both ISA and PCI slots, it’s probably too old!)

**XenaHD2**

The XenaHD2 PCI specifications and requirements are identical to those of the XenaHD.

**XenaSD2**

The XenaSD2 PCI specifications and requirements are identical to those of the XenaHD (not the XenaSD). The XenaSD2 board is a 66 MHz board.

---

**Disk arrays and PCI performance for XenaSD**

For the XenaSD, we recommend a dual-channel ultra320 SCSI controller such as the ATTO UL4D, or the Adaptec 39320. A 2-Gigabit Fibre Channel host bus adapter also works well. The recommended configuration is four (4) 10K disk drives, (such as the Seagate Cheetah Ultra320 10K-6 or the Maxtor Ultra320 10K-3). The minimum requirement is an ultra160 controller (such as the ATTO UL3D or Adaptec 39160) with Ultra-320 10K disks.

Disk throughput requirements vary according to the video format used.

The data rate for 8-bit UYVY and YUY2 video is 21 MB/second per channel. At this rate, the disk system must be able to sustain 21 MB/second, with at least 42 MB/second system PCI performance (for each channel), as the data must go from the AJA Xena card to main memory, and then from main memory to the disk.

The data rate for RGB video is 42 MB/second per channel. At this rate, the disk system must be able to sustain 42 MB/second, with at least 84 MB/second system PCI performance for each channel.

---

**Disk arrays and PCI performance for XenaHD**

For the XenaHD, we recommend a dual-channel ultra320 SCSI controller such as the ATTO UL4D, or the Adaptec 39320. A 2-Gigabit Fibre Channel host bus adapter also works well. The recommended configuration is eight (8) 10K disk drives, (such as the Seagate Cheetah Ultra320 10K-6 or the Maxtor Ultra320 10K-3) with four disks connected to each SCSI channel. The minimum requirement is an ultra160 controller (such as the ATTO UL3D or Adaptec 39160) with Ultra-320 10K disks. Disk throughput requirements vary according to the video format used.

The data rate for YUV video is 124 MegaBytes/second for UYVY and YUY2 1080i, 30 fps. This rate requires a disk system that can sustain 124 MB/second, with at least 248 MB/second system PCI performance (for each channel), as the data must go from Xena to main memory, and then from main memory to the disk.
The data rate is 100 MB/second for 8-bit 1080i at 24 Hz. At this rate, the disk system only needs to sustain 100 MB/second, with at least 200 MB/second across the PCI bus.

For RGB, 30 fps, the data rate is 249 MB/second. This rate requires a disk system that can sustain 249 MB/second, with at least 498 MB/second system PCI performance, per channel.

Data rates are slightly less for 720p format:

- 720p/60fps YUV is 111 MB/second disk transfer rate, with 222 MB/second PCI.
- 720p/60fps RGB is 222 MB/second disk transfer rate, with 444 MB/second PCI.

If the test PCI performance as measured with the XenaHD benchmark utility (Start->AJA-Benchmarks->Test Disk Speed) indicates inadequate speed, consider using a PC with more efficient PCI architecture (such as PCIX) or with a faster Frontside Bus.

**PCI Bus Latency**

PC motherboards with Hypertransport (such as the AMD Opteron systems) may require changing the PCI latency timer to get acceptable PCI performance. For the fastest DMA speeds, use the maximum “PCI Latency” in your PC’s BIOS setup.

---

**Block Diagram**

---

*Xena, Block Diagram*
I/O Connections

XenaHD and SD Card Modules, Side View

XenaHD

XenaSD

XenaHD2 and SD2 Card Modules, Side View

XenaHD2

XenaSD2
A group of BNCs on the card edge plate provide I/O for the module—3 for XenaHD/SD and 5 for XenaHD2/SD2. The illustration above shows the connectors available when the card is installed in a PC.

**AES/EBU Audio Inputs And Outputs (SD/HD only)—15-pin D-connector**

One female 15-pin D connector is provided for six channels of AES/EBU inputs and outputs. The connector attaches to a six-XLR breakout cable supplied with the Xena card module. Xena AES/EBU audio is 24 Bit/48Khz. All AES inputs support asynchronous audio at 32-96Khz. This connector is not present on the XenaSD2/HD2 boards.

**Reference Input—BNC**

This BNC connector allows you to synchronize outputs to your house reference video signal (or black burst). If you have a sync generator or central piece of video equipment to use for synchronizing other video equipment in your studio, then connect its composite output here. When Xena outputs video it uses this reference signal to lock to.

**SDI Input and Output—2 BNCs (SD/HD) or 4 BNCs (HD2/SD2)**

These BNC connectors are for connecting serial digital video input and output devices (respectively). On the XenaSD, the signals are 10-bit or 8-bit SMPTE-259. On the XenaHD, the signals are high definition serial digital, 10-bit or 8-bit SMPTE-292. Xena SD2 and HD2 boards have two channels of I/O and thus have two sets of BNCs (4 in all).

**Using Xena With Application Software**

The Xena card is configured with a supplied control panel that is installed as part of the normal software installation. Once configured, the Xena board can be used with a variety of Windows Media applications and 3rd-party software such as Adobe Photoshop, After Effects, and others. In some cases supplied plug-ins provide the 3rd-party software with special control features for using Xena capabilities.

**Control Panel**

The Xena Control Panel offers a way to select specific board settings, generally not selectable from standard applications. Through the Control Panel, you can choose the Video Format, select the Video Reference source, output test patterns, and control Dither for 8-bit inputs.

For Windows Media applications, you can alter the Audio/Video synchronization values in the Control Panel Preferences, and modify the default behavior of the Windows Media Player.

If you have more than one Xena board installed, you can run one Control Panel for each board installed.

**Video Settings—Choosing Format and Reference Source**

For video Capture applications, set the Reference Source to “Input 1.” For Playback-only applications, instead set the Reference Source to “Free Run.”

To GenLock your system to the “Reference In” signal, set Reference Source to “External.”

For Windows Media applications, you don’t have to select “Input 1” as the reference source for Capturing. When the board is put into Capture mode, the system automatically uses “Input 1” as the capture source. When not in Capture mode, the system uses the Reference selected in the Control Panel. For non-Windows Media applications, such as Photoshop, you do have to select sources manually.
**Video Format** settings you can choose, include:

**HD**
- 1080i 50.00 Hz.
- 1080i 59.94 Hz.
- 1080i 60.00 Hz.
- 720p 59.94 Hz.
- 720p 60.00 Hz.
- 1080p sf 23.98 Hz.
- 1080p sf 24.00 Hz.

**SD**
- 525 59.94 Hz.
- 625 50.00 Hz.

**Reference Source** settings you can choose, include:

- **Reference Input**: Use Reference Input for Reference Source
- **Input 1**: Use Input 1 for Reference Source
- **Input 2**: Use Input 2 for Reference Source
- **Free Run**: Free Run Output

The Video Settings window reports on the status of the three Xena board inputs (Reference, Input1 and Input 2).
Test Patterns
This tab in the Control Panel allows you to output a known video signal from the Xena output for testing purposes. When exporting, you can choose which components you wish to export (Y/Cb/Cr). Checking all the boxes downloads all the components of the chosen test pattern. Test patterns available include:

- 100% Color Bars
- 75% Color Bars
- Ramp
- Multiburst
- Linesweep
- Pathological
- Flat Field
- Multipattern
- Black

![Xena Control Panel, Test Pattern Settings](image)
Capture

A capture window provides you with the ability to directly grab frames or fields from a selected video input channel (1 or 2, depending on Xena board type) and then save them locally on the PC at a selected size (Capture Size 25, 50, 75 or 100%), file type (Capture To BMP, JPEG, YUV, or TIFF), and location (destination folder and filename on your hard drive or network). Alternatively, you can also save the frame/field to the Windows clipboard for pasting into a graphics or video application. For compressed JPEG files, you can also specify a JPEG Quality level.

If Input1+Input2 is chosen as the “Capture From”, it is assumed that Input 1 is Video and Input 2 is Key. If you are capturing to a TIFF file, the Key Input (Input 2) is converted to an alpha channel and included in the TIFF file. Also, if YUV file is chosen as the Capture To choice, the Video File is then written to the Filename field and the Key is written to a corresponding Key YUV file. Thus, if the Filename field has HDCapture.yuv, then Input1 will be captured as HDCapture.yuv and Input 2 will be captured as HDCapture.Key.yuv.

Notes:

1. While this dialog is active, Xena remains in capture mode. In capture mode, the board routes the input to the output. The board automatically reverts to display mode when you exit the dialog.
2. The dialog does not warn you if it is going to overwrite a file.

To perform a capture, simply make your capture size and quality settings and then click on the Capture button.

Auto Increment: When checked, this causes Xena to append a number to the filename you enter, and then it increments that number after each capture. In this manner, you can keep clicking the capture button to capture a series of separate files without having to specify a filename each time.

Convert Aspect: Aspect Convert affects only SD cards. If the button is checked while in 525 mode, it stretches a 648x486 image to 720x486. In 625 mode it compresses a 768x576 image to 720x486. Such conversion may be necessary because in television pixels are rectangular rather than square, and yet computer
monitors only display square pixels. So to ensure that circles display as circles, for example, you may need to convert the pixel aspect ratio by selecting this checkbox.

Windows Media Preferences—Set Dither
You can select dithering for 8-bit video inputs via a checkbox on the Windows Media Preferences page.

64-Bit Slot
When a XenaHD, XenaHD2 or XenaSD2 is inserted into a 64-bit PCI slot, it can perform 64-bit transfers. (Xena SD is a 32-bit card.) However, some older Xena boards may not automatically detect the 64-bit slot in some PCs. In such a case, enable the “64-bit PCI slot” checkbox to get full 64-bit transfers.

Note: enabling this checkbox when the board is in a 32-bit slot actually slows performance.

If you have a XenaHD, XenaHD2, or XenaSD2 installed in a 64-bit slot, you should check this box—it will not happen automatically.

Windows Media Preferences—Set A/V Synchronization
Each Windows Media application may have differing requirements for Audio/Video synchronization, due to inherent delays in the application or in the different codecs used for processing media. These same delays may also vary slightly from one PC to another due to hardware differences. Using the Xena Control Panel “Windows Media Preferences” tab, you can change the initial delay values for the Audio and Video streams. Adjust the supplied sliders if your Audio and Video are not sufficiently in sync.

Video Playback Delay—Adjust this slider to change the Video Delay relative to the Audio (during playback). A value of 0 means that neither Audio or Video are delayed (other than inherent delay). A negative value means that Video is not delayed, but Audio is delayed, by the number of milliseconds specified. A positive number means that Video is delayed one frame (33.3 mS at 59.94 Hz), and Audio is also delayed, using this algorithm:

\[ \text{“audio delay”} = (\text{integer # of frame periods} + 1) \times \text{“frame period”} - \text{“specified video playback delay”} \]

The default 48 milliSecond Video Playback Delay, for instance, is implemented (at 59.94 Hz) as 2 frames of Video Delay and 18 milliSeconds of Audio Delay.
**Audio Record Delay**—change this slider as necessary for synchronization of audio during recording. (There is no video delay available for Record.) A factory default value of 10 milliseconds provides synchronized audio and video when using Windows Media Player to playback a “.wmv” file to the computer monitor.

**Strict Timing (default Off)**—The Strict Timing setting enables software which enforces strict frame output timing for Windows Media video rendering. (In technical terms, this enforces a strict correlation between Presentation Time Stamps and the Graph Clock.) This setting has no effect on video capture.

Under adverse conditions (slow disk, high CPU Usage, clock inaccuracies, etc.), the computer may not be able to send video frames to Xena fast enough for proper playback. (This is especially true when playing .AVI files.) In such a case, setting the “Strict Timing” control to “Off” will allow rendering of the video at low speed. (With Strict Timing set to “On” for this case, the video playback may “freeze” after playing for a short duration.)

When playing video for long periods of time, the clock used by Windows Media is not accurate enough to allow proper playback at true broadcast video rates, unless software compensation is used. With Strict Timing enabled, the Xena software corrects for clock drift and jitter caused by the inaccuracy of the DirectShow clock and time-stamps. The drift-correction and anti-jitter algorithms allow temporally-accurate rendering of long video streams. When using the Strict Timing setting, make sure that your PC is powerful enough to avoid delayed delivery of video frames due to lack of system resources. (This could cause the playback to “freeze”, waiting endlessly for a frame with a valid time-stamp!)
In Xena software versions prior to 5.2, the Strict Timing setting was in effect “On”. For 5.2, we have added the option to turn it “Off”. In fact, in order to allow playback under adverse conditions, we have opted to make “Off” the default condition. If you need accurate frame timing of your playback video, you should turn Strict Timing “On”.

**Windows Media Preferences—Windows Media Player Preferences**

The Windows Media Player Preference settings alter the system registry and take effect only after a reboot.

**Note:** Windows Media Player may operate with reduced functionality until the reboot is executed. Also, administrator privileges are required to be able to set the Windows Media Player Preferences.

Settings you can select are as follows:

- **Output to Xena Board**—When selected, the Windows Media Player will not output video to its own window on the computer monitor, but will instead play video to the Xena SDI output.

- **Output to Windows Media Player Window**—Selecting this restores the Windows Media Player output to normal.

**Note:** other applications may be affected by this configuration, if they use Windows Media Player components for Preview, etc.

---

**Caution:** If you uninstall the Xena board or move it to another slot, you should first restore this preference to “Output to Windows Media Player Window”. This will prevent the use of invalid registry files. If you have more than one Xena board installed in a machine, only one of them can be configured for output from Windows Media Player. If you try to configure both for Windows Media Player output, you may get invalid registry files.

**Technical Note:** The mechanism used to perform Windows Media Player re-configuration involves making changes to the registry, and adding files to your WINDOWS/SYSTEM32 directory. Original registry settings are saved to files in the directory where you installed the Xena Control Panel (C:\Program Files\AJA\XenaSDControlPanel by default). There are six registry files saved; they are: Registry_DefaultVideoRenderer; Registry_FilterClassMgr_VMR1; Registry_FilterClassMgr_VMR2; Registry_PlayerDMOs; Registry_VideoMixingRenderer; and Registry_VideoRenderer. When Media Player configuration is restored to normal, these saved registry settings are restored. Note that these settings are specific to your machine, and even to the particular PCI slot where the Xena board is installed.

**Video Processing Settings**

The Video Processing tab in the Windows Media Settings Control Panel allows you to actively use the built-in video processing capabilities of the Xena card. On this tabbed page you can select from different video sources, and even mix or wipe between them.

When the Xena Control Panel Application starts up, video processing is disabled. No mixing occurs and Channel 1 Video routes to Output 1, with either Channel 1 Key or Channel 2 Video going to Output 2. If an alpha channel is exported, then Channel 1 Key goes to Output 2. If a Video Source is exported to Channel 2, then Channel 2 Video routes to Output 2. For example, if you output a TIFF file with alpha, the alpha channel would go to
Output 2. If instead, a Channel 2 Test Pattern was exported, it would go to Output 2. To enable the video processing, click the “Enable” checkbox.

**Xena Control Panel Windows Media Settings, Video Processing Settings**

**Enable**—when checked, this turns video processing on. If unchecked, video is passed without any mix/split/key etc.

**Vid Proc Mode**—selecting one of these buttons chooses a function (Mix video, split video, or key) to be performed on the sources selected in the pulldowns to the right of the buttons.

**Mix**—When video processing is enabled and Mix is chosen, the Mix Coefficient slider is active. This slider mixes from Foreground Video to Background Video.

**Split**—When video processing is enabled and Split is chosen, both sliders are enabled and they perform either wipe or slit operations. See Split Mode discussed later.

**Key**—When video processing is enabled and Key is chosen, the Foreground key will cut a hole in the Background Video and insert the Foreground Video.

**Split Mode**—selects a transition to be applied, wipe or split, that can be adjusted using the slider controls at the right.

**H Wipe**—In this mode, the Wipe Position and Wipe Softness sliders are active. The Wipe Position slider, wipes from Channel 1 Video (leftmost position) to Channel 2 Video (rightmost position). The Wipe Softness slider goes from no softness to softness covering a quarter of the raster.

**V Wipe**—In this mode, the Wipe Position and Wipe Softness sliders are active.
The Wipe Position slider, wipes from Channel 1 Video (leftmost position) to Channel 2 Video (rightmost position). The Wipe Softness slider goes from no softness to softness covering a quarter of the raster.

*H Slit*—In this mode, the Slit Start and Slit Width Sliders are active. The Slit Start slider determines where the first transition between Foreground Video (left) and the Background Video (right) occurs. The Slit Width determines how wide the Background Video is shown before it transitions back to the Foreground Video.

*V Slit*—In this mode, the Slit Start and Slit Width Sliders are active. The Slit Start slider determines where the first transition between Foreground Video (top) and the Background Video (bottom) occurs. The Slit Width determines how wide the Background Video becomes before it transitions back to the Foreground Video.

**Output 2**—Available only on XenaSD2 and XenaHD2 boards, this selects which content is routed to the card module’s Output 2 BNC connector. You can choose the background or foreground only, or a mix of the key and video (as configured in Vid Proc Mode).

Background Video—If video processing is not enabled, Channel 2 Video is selected as Background Video.

Foreground Video—If video processing is not enabled, Channel 1 Video is selected as Foreground Video.

Foreground Key—If video processing is not enabled, Channel 1 Key is selected as Foreground Key.

**Export**—click on the *Select File* button to choose a graphics file to export to each channel’s current output frame. A file selection dialog will be displayed allowing you to select any file the PC has access to locally or on an attached network. Supported file types you can choose are bitmap, JPEG, TIFF, and Targa.). You can use the “Select File” mechanism, or drag-and-drop a file onto the Control Panel.

Using Xena With Adobe Photoshop

Xena comes with several Adobe Photoshop plug-ins that allow you to import and export still files from the card. There are several subdirectories in the Adobe Photoshop Plug-ins folder; the Xena plug-ins will work if placed anywhere under the “Plug-Ins” directory. Once placed in the plug-ins folder, you will be able to use the plug-ins in Adobe Photoshop from the Photoshop File menu, under the Import and Export menu items.

**Note:** The plug-ins also work with Adobe PhotoDeluxe.

**Import Plug-in**

The Import plug-in is responsible for importing stills from the Xena board into Photoshop. The import function from photoshop is activated via the *File->Import->Xena Import* menu selection. While the import dialog is displayed the video signal going into the Xena board will be looped back out the output BNC. The Plug-in will import a still each time the “Import” button is pressed. The “Done” button ends the dialog. The import dialog is shown below.
The photoshop import plug-in has a control called “Acquisition Mode.” This control selects whether the entire Frame is imported or if Field 1 is imported. If there is motion video on the input then Field should be chosen.

**Note:** If you want to control which field is imported, import the entire frame and choose the Photoshop deinterlace function.

### Export Plug-in

Use the Export plug-in to export a Photoshop image to the Xena board for serial digital output. You can find the Xena export function from Photoshop’s `File->Export->XenaExport` menu selection. The Xena export plug-in currently only exports RGB Mode 8 bit images. The export dialog is shown below.

#### Windows NT Xena Export Dialog

The only control available in the dialog is Vertical Filtering. When the Vertical Filtering box is checked, the photoshop image is filtered in the vertical direction before exporting to the Xena card. Check the box when you want to decrease flicker caused by computer graphics non-interlace conversion to interlaced video. When checked, Xena performs vertical filtering using a three line kernel, whereby half of the current line’s pixel values are combined with a quarter of each of the previous and next line’s pixel values. The boundary conditions (first and last line) use black for the boundary values.

**Usage Notes:**

1. The exported image will be output based on the Format set in the Xena Control Panel. For example, if the image or selected part of the image is not full size, the image will then be centered on the output. If the image or selected part of the image to be exported is larger than full size then only the upper-left most part of the image will be exported. Photoshop can be used to resize the image accordingly.
2. If there is a selection via the Marquee tool the plug-in will export only the selected part of the image. If a non-rectangular selection is made however, the entire bounding rectangle is exported.

3. It is useful to use the Actions palette to avoid having the dialog come up for each export. It can also be useful to assign the action to a function key if the export function is used often.

Using Xena With Adobe AfterEffects

Xena comes with an Adobe AfterEffects plug-in that allows you to route the AfterEffects composition window to the Xena board’s selected output channel. No AfterEffects menus or windows are changed or altered in any way. As long as the supplied AJA plug-in is put in the AfterEffects plug-in folder, the composition window will be available at the Xena output. The plug-in can be found in the “AfterEffects” folder on the Xena Installation CD (as discussed in the Installation topic in the manual you are reading).

For proper operation, the AfterEffects composition window must be sized to match the resolution as set on the Xena board for output. The following list gives the settings:

- If 525, set to 720 x 486
- If 625, set to 720 x 576
- If 720p, set to 1280 x 720
- If 1080, set to 1920 x 1080

On the Xena boards with two outputs (XenaSD2 and HD2), output of the composition window occurs on Channel 2.

Using Xena With PowerCG

The Xena boards support PowerCG, a powerful Character Generator for video titling, animation, image viewing and editing. PowerCG is available in several versions from Cayman Graphics.

Use of PowerCG with Xena is completely transparent. No user interface changes (menus etc.) are altered by Xena software. By adding the AJA “PCG_HWFA.DLL” file located in the PowerCG directory on the Xena Installation CD to the PowerCG folder, the Xena board outputs PowerCG video and title key.

- Cayman Graphics Sales (801) 254-6979, email: Info@CaymanGraphics.com
- Cayman Graphics Support (801) 597-4240, email: Support@CaymanGraphics.com

In PowerCG—

1. Go to Settings > User Preferences
2. Set User Preferences > Change Video Format
   NTSC: Rectangular Pixels 720 by 486
   or PAL: Rectangular Pixels 720 by 576
   or HDTV: 1920 by 1080
   or HDTV: 1280 by 720

In Xena Control Panel—set the Control Panel Video Format to a compatible value.

To key over still images, disable video processing via the Xena control panel and then select “No Graphic on Background Image” tab in PowerCG.

In PowerCG, to key over input video:

1. In PowerCG, Select File > New.
2. In the Xena Control Panel, go to “Video Processing” tab and set it as follows:
If you want embedded audio to pass through and output along with the video then make these settings in the “Wave In Mixer Dialog” (see page 26):

Using Xena With ThumbsPlus

ThumbsPlus is a highly customizable image database/thumbnails/graphics editor application that makes it easy to catalog, locate, maintain and modify all your graphics and multimedia files. ThumbsPlus is available in Standard and Pro versions. ThumbsPlus has several features which allow it to work with the Xena board. By default, dragging a file’s thumbnail from ThumbsPlus to the Xena Control Panel’s “Video Processing” page will export the file to the board. It is also possible to double-click on a thumbnail within ThumbsPlus to initiate the export. For most file types, this works using the default settings for ThumbsPlus. To get ThumbsPlus to export an ‘unusual’ file type by double-clicking on the thumbnail, however, we must first set up some new File Type Configurations in the ThumbsPlus “Preferences” property-page.

Working with ThumbsPlus

ThumbsPlus can be configured to copy a graphics file to the clipboard when a thumbnail is double-clicked (instead of viewing the file on the desktop). With the AJA-supplied utility “copyname.exe”, ThumbsPlus can also be configured to copy the name of a graphics file to the clipboard when a thumbnail is double-clicked. Either way, Xena can then Export the file from the clipboard to either Channel 1 or Channel 2. The clipboard can be continuously monitored by the Xena Control Panel, and an Export operation performed every time the clipboard is updated with a new graphics file.
YUV Files and ThumbsPlus

Xena can import and export files in native “YUV” format, which preserves color information pristinely, since there is no color-space conversion to RGB involved. ThumbsPlus displays YUV files well, so integration with Xena and its Control Panel can be made by only making settings in “ThumbsPlus Preferences” within ThumbsPlus.

Clipboard ‘image’ interface

If you don’t want the quality of using YUV files, you can use the simpler Clipboard “image” interface where images are copied in RGB to the clipboard instead of filenames. If you want to support YUV files in ThumbsPlus, however, you’ll need to use the Clipboard “filename” interface. You must also configure ThumbsPlus to use the YUVFormat Photoshop Plugin (supplied on the Xena installation CD) as the viewer for YUV files. (See the topic “Supporting YUV Files within ThumbsPlus” that follows later in this discussion.)

To configure ThumbsPlus to copy an image to the clipboard when a thumbnail is double-clicked, go to the ThumbsPlus “Options” menu, and select “Preferences.” In the Preferences dialog’s “General” tab, select “Copy to clipboard.”

ThumbsPlus Default Action (for Double-click) - Copy to Clipboard
Clipboard ‘filename’ interface

To support YUV files, ThumbsPlus must copy the filename of the image to the clipboard instead of copying the actual image. How to configure this is discussed later in “Supporting YUV Files within ThumbsPlus.”

For now, go to the ThumbsPlus “Options” menu, and select “Preferences”. In the Preferences dialog’s “General” tab, select “Edit image.”

When ThumbsPlus Integration is set up, ThumbsPlus puts the filename in the clipboard and Xena then takes the new clipboard content or name of a graphics file and automatically exports it to Channel 1 (XenaSD/HD) or Channel 2 (XenaSD2/HD2).

ThumbsPlus Default Action (for Double-click) - Edit image

Supporting YUV Files within ThumbsPlus

ThumbsPlus can support YUV format files, when properly configured.

Adding a File Type Configuration. First we must Add a File Type Configuration for YUV files:

1. From the ThumbsPlus “Options” menu, select “Preferences”.
2. In the Preferences dialog’s “File Types” tab, select “New...” to bring up the “File Type Configuration” dialog.
3. Type “yuv” in the “Extension” edit-box.

![ThumbsPlus File Types property page after “yuv” type is added](image)

**Showing YUV Thumbnails.** To set YUV as one of the File types to show in the thumbnail view:

1. Go to the “File Types” property-page in the ThumbsPlus “Preferences” dialog.
2. Check the “yuv” File Type.
Using the Photoshop Plug-in to Load YUV files

ThumbsPlus uses a PhotoShop Plug-In to load the YUV files. To configure this:

1. Under the Preferences “File Types” tab, select the “yuv” file type and then click the “Edit...” button to bring up a “File Type Configuration” dialog for yuv files.

2. Press the “Hunt for filters & plug-ins...” button at the bottom of the dialog. Make sure the Hunt includes the drive, where the YUVFormat Plug-in was copied when you originally installed the software (as described in the installation topic later in this manual).

3. Select “Photoshop Plug-in” under “Load file using:”, and, to the right of the “>>” to specify which Photoshop Plug-in to use. For example, it might be similar to: “YUVFormat.8bi (c:\Program Files\Adobe\Photoshop\plugins\YUVFormat.8bi)”.

---

1. copyname.exe is copied to c:\Program Files\AJA\ (or another specified installation directory) as part of the ThumbsPlus “Xena Tools and Manuals” installation on the AJA installation CD-ROM. The YUVFormat.8bi file is installed by manually copying it from the “Photoshop Plug-ins” folder on the AJA installation CD.
Using “copyname” as the Default Action

1. From the ThumbsPlus “Options” menu, select “Preferences.”
2. In the Preferences dialog “General” tab, select “Edit Image.”
3. In the Preferences dialog “File Types” tab, select “New...” to bring up the “File Type Configuration” dialog.
4. Select “Command” under “Edit file using:”, and to the right of the “>>”, specify which command to use, type “c:\Program Files\AJA\copyname.exe” (or other installation directory) as the command line.

Reconciling Standard File Types With The “Edit” Default Action

Since you have set the default action (under the General tab of ThumbsPlus Preferences) to “Edit image” to accommodate exporting of yuv files, you must also make sure the default action (now Edit Image) does something appropriate for other file types as well.

For each file type of interest:
1. Select the file type under the “File Types” tab of the ThumbsPlus Preferences dialog.
2. Select “Edit...” to bring up the File Type Configuration dialog.

File types of interest—those supported by the Xena card—are: BMP, JPG, TIFF, TGA, EPS, PCT, and YUV.

For information about using ThumbsPlus, contact:
- Phone: 1-877-CERIOUS (1-877-237-4687)
- Cerious Support email: support@cerious.com
- Web: http://www.cerious.com
Windows Media Audio Configuration

Xena provides 3 audio devices that can be selected by Windows Media applications. It can also be configured as the default system sound device for the computer. To select Xena as the default sound device:

1. Go to the Start Menu / Control Panel, and choose “Sounds and Audio Devices.”
2. Select the Audio tab.
3. Under “Sound Playback”, “Default Device”, choose “Xena-SD Audio (1)” to use AES channels 1 and 2 as the default sound playback device. [Use “Xena-SD Audio (2)” for channels 3-4, or “Xena-SD Audio (3)” for channels 5-6.] Similarly, you can choose a Xena audio device as the default sound recording device.

The audio settings on Xena can be configured with the “Sounds and Audio Devices” applet of the Windows Control Panel. Through the “Sounds and Audio Devices” applet (mixer dialog), you can control the Volume and Balance of Wave, Synth, and CD Player sounds played throughout the Xena. You can also control whether Xena audio output is in ‘Monitor” mode, “Tone” mode, or normal “Wave Out” mode (explained later).

You can also configure Xena to record from the AES audio input, or from one of eight pairs of Embedded Audio channels.
Sound Playback controls

These instructions discuss setting volume and mix levels for Xena.

1. Go to Start Menu > Control Panel > Sounds and Audio Devices > Audio.
2. Select the “Volume...” button for Sound Playback. This should bring up a Mixer dialog.
3. In the Options menu of the Mixer dialog, select “Properties”.
4. In the mixer device Properties dialog, select “Xena-SD Audio (1)” as the mixer device.

At least one of the Xena volume controls must be enabled in order for the Mixer dialog to be accessible under “Volume...” (when a Xena device is also selected as the Default Device for sound recording). In order to control all aspects of Xena, check all the check-boxes, including “Wave Out”, “Tone”, and “Monitor.”

Properties Dialog

5. After pressing “OK” in the Properties dialog, you should see a full mixer dialog:
Audio Mixer Dialog

The “Wave”, “SW Synth”, and “CD Player” controls function the same as with any system sound device. (These sources are mixed with the Xena output as specified by the Volume sliders.) The “Wave Out”, “Tone”, and “Monitor” controls specify the mode of the board. The “Wave”, “Tone”, and “Monitor” controls are mutually exclusive. When “Wave” is selected, the normal Xena output is selected. When “Monitor” is selected, the audio input to the Xena is directed straight to the audio output. (This is useful for listening to the audio while recording.) When “Tone” is selected, a continuous test tone is output to all Xena output channels.

Note: Volume and Balance sliders are disabled for the Wave Out, Tone, and Monitor sources. These are pure digital sources, and are never attenuated.

Sound Recording controls

These only need to be set if you are using embedded audio. To adjust the Recording controls for the Xena card, follow these steps:

1. Select the “Volume...” button for Sound Recording. This will bring up a Mixer dialog. (If it does not bring up the mixer dialog, see below.)
2. In the Options menu of the Mixer dialog, select “Properties.”
3. In the mixer device Properties dialog, select “Xena-SD Audio Device (1)” as the mixer device. If you want to be able to select between AES audio and Embedded audio, you should check all the check-boxes.
4. If an “Analog In” control is displayed, you may leave it unchecked since XenaHS has no analog audio.

The error message “There is a problem with your sound hardware” may appear when attempting to access the Mixer dialog for a Xena Audio Device—if there are no volume controls enabled for that Device. (This may be confusing since the volume controls are enabled from within the Mixer dialog.) To correct this, select the “Volume...” button in the “Sound recording” area. If “Volume...” is not available for “Sound Recording”, choose “Volume...” in “Playback,” choose “properties” from the Options menu, and then switch to “Sound recording.” Then, in the Mixer dialog Options menu > Properties, select a Xena device under “Mixer device”, select “Adjust volume for Recording”, and then enable the available Xena volume controls. At least one volume control must be enabled in order for the Mixer dialog to open properly. Under Windows 2000 there may be no volume controls available for sound recording; please contact AJA if you need to record embedded audio.
Mixer Device Properties Dialog

5. After pressing “OK” in the Properties dialog, you should see a full mixer dialog:

Mixer Dialog, Wave In

To record from the AES audio inputs (connected to the D-connector on the Xena board), select “AES in Ch. 1-2.” Note that “AES In CH 3-4” and “AES In Ch 5-6” can be accessed via “Xena-SD Audio (2)” and “Xena-SD Audio (3)”.

To record from audio embedded in the SDI video stream, select one of the pairs of channels from the desired embedded audio group.
Enabling/Disabling Xena as a System Audio Device

Xena shows up in the system as another Audio I/O device under the Windows control panel “Sounds and Audio Devices” (XP). Inside the control panel, go to Hardware > “AJA Xena Digital Audio” and click the Properties button. Then under the Properties tab, look under Audio Devices and double-click AJA Xena Digital Audio. At this dialog, you can choose to either “Use audio features...” or “Do not use audio features...” on the Xena card. A reboot may be necessary before any changes take effect.

Windows Media Applications

Using Xena with Windows Media Encoder 9

Windows Media Encoder can be used to compress and broadcast video over the internet. When coupled with a high-quality video source like the Xena board provides, Windows Media Encoder can transmit a high-quality audio/video stream with a relatively small bandwidth. Windows Media Encoder is available for download from Microsoft Corporation, at www.microsoft.com/windows/windowsmedia. (Encoder 9 or later is required for use with Xena.)

Setup

Windows Media Encoder configuration files are included on the Xena release CD, in the “Application Files” folder. These files contain the proper settings for basic operations with the Xena board.

To encode for live webcast or archiving to a file, select the “Xena Capture Device” as the Video Device. Select “Xena Audio (1)” as the Audio Device.

Note: The Mixer button in the Audio Panel may not function correctly if the Windows Control Panel > Sounds and Audio Devices > Audio tab does not have the Xena device selected as the system default Sound Recording device. (This is a unique behavior of Windows Media Encoder.) If pressing the “Mixer...” button results in the error message: “There is a problem with your sound hardware.”, you can remove the error by selecting the Xena Audio Device as the system Default Device for sound recording. (See the “Windows Media Audio Configuration” topic discussed earlier in this document for mixer set-up issues.) Alternately, you can access the Xena Audio Device mixer properties by using the “Volume...” button in the Sounds and Audio Devices Properties tab of the Windows Control Panel.

The Windows Media Encoder must be configured to set the Video Size to a Xena-supported frame size (720 x 486 or 720 x 576 for XenaSD). In the Compression Properties dialog, select “Edit...”. Then, under the tab for each selected bitrate, choose Video Size as “Same as video input.” For PAL signals, you must explicitly specify 720 x 576—selecting “Same as video input” will not result in the proper size.

For 25 frame-per-second (PAL) video, you must turn on “deinterlace” (in the Processing tab). Windows Media Encoder 9 help files specify that “Maintaining interlacing in source video when encoding at a low frame rate (for example, 15 fps) can introduce undesirable artifacts in the encoded content. Therefore, if you are encoding at a low frame rate, it is recommended that you deinterlace the video, even if the content is intended for display on an interlaced playback device.” Although not mentioned in the note, this seems to also apply to 25 fps video.
For Best Encoder Performance

For best performance, dismiss the Preview window while encoding. Note that the Preview window launches automatically when encoding starts, unless “Automatically show panels needed for the current session” is turned off in the “Tools > Options” dialog.

**Note:** trying to preview while Windows Media Player is configured for Xena output will cause the encoding session to fail to start.

One of the native video formats offered by Windows Media Encoder is “YUY2.” (RGB32 and UYVY both require software translation.) For best performance, select “YUY2” as the “Pixel format” on the “Processing” properties page. Using “default” may result in jerkiness in the output video.

If you don’t see smooth video after adjustment, consider moving the Performance slider to “Better performance” (Tools > Options > Performance). It may also be useful in some cases to enable “Capture to hard disk first” in “Properties > Advanced.”

Encoder Configuration

In the Encoder’s Device Configuration dialogs, there isn’t much of use for configuring Xena. The Xena video, being completely digital, has no settings to configure. In the audio configuration for Xena, there is only the ability to choose between AES audio as the input, and any of the available embedded audio pairs (and this does not work properly from the Encoder dialog). Changes to the “Pin Line” here will have no effect. To change between AES audio and Embedded Audio channels, you must use the full mixer dialog. (See the “Sound Recording controls” topic presented earlier for further information.)

It may be useful to put the Xena audio into “Monitor” mode, in order to hear the audio that is being encoded. For instructions on how to select Monitor mode in the Mixer dialog, see the “Windows Media Audio Configuration” topic presented earlier.

Uncompressed video. You can use Encoder to capture uncompressed video to a .wmv file. The file can then later be encoded. To capture uncompressed, use “Windows Media Server” or “Web Server” as the Destination in the Compression Properties page. In the Compression Properties dialog, select “Edit...”. Then choose “Full Frames (uncompressed)” as the Codec. For saving uncompressed video to disk, you will need a fast disk system. (See requirements section.)

To encode from an uncompressed file, choose “Source from: File” in the Sources tab of the Session Properties.

Processor requirements. Note that, in the case of the XenaHD, the amount of processor power required to encode live video in real time may be greater than that available in a standard PC system (it is estimated that at least a dual 4 GHz system would be required.) To properly encode HD, you may have to save uncompressed video to a file on a RAID, and then encode the resulting file.

Using Xena with Windows Media Player 9

Windows Media Player can be configured to output video through the Xena board instead of playing to its own window on the PC monitor. In this configuration, Windows Media files can be played out to any device with an SDI input, such as a VTR or television monitor. (Windows Media Player 9 or later is required.)

---

1. There are two ways to get to the “XenaSD Audio Device (1) Properties” dialog: a) from the “Sources” tab on the “Session Properties” page, select “Configure...”; b) select “Configure Devices...” from the “Tools” menu., then select the “XenaSD Audio Device (1)”, and “Configure.”
Windows Media Player reconfiguration is achieved via the Xena Control Panel. Configuration controls are found in the “Windows Media Player Preferences” on the “Windows Media Settings” tab of the Control Panel.

It is best not to configure a machine for Xena output if that machine will also be used for capturing or encoding. Doing so prevents Preview on the computer monitor for most capture applications, since they usually utilize components of Windows Media Player. In some cases, other complications can also occur. For Windows Media Encoder, encoding fails if Preview is turned on in this configuration. (To turn Preview off in Windows Media Encoder, go to the “Tools > Options” dialog and disable “Automatically show panels needed for the current session.”)

When configured for Xena output, Windows Media Player only plays files with a correct video size for XenaSD (720x486, 720x576, or 720x480). To play back other sizes, use the GraphEdit application—read the next topic for details.

**Using Xena with GraphEdit**

GraphEdit is a low-level Microsoft tool for Windows Media application developers. It is not recommended for typical Xena end-users, however it’s useful to know about since it has some capabilities not currently available through Windows Media Player. GraphEdit is available from Microsoft as part of the DirectX SDK; it can also be installed from the Xena Installation Software CD by selecting the “Tools and Manuals” button from the installation screen. When installed using the “Custom” installation “Setup Type”, it shows up on your PC under the Start menu:

Start > All Programs > AJA > Diagnostics > Graph Edit

If the Windows Media Player configuration has been configured to output to Xena (via the Xena Control Panel), then GraphEdit will also use Xena as the default video renderer.

It is not necessary to reconfigure Windows Media Player in order to render to Xena in GraphEdit. Instead, in the “Graph > Insert Filters” dialog, manually choose “WDM Streaming Rendering Devices > Xena-SD Video Render” when building a graph.

When playing back .wmv files through GraphEdit, video sizes other than the native Xena sizes will play back through GraphEdit in a corner of the television screen. To play back full-screen non-native sizes, you must insert a resize filter, such as the one available from Lead Technologies (http://www.leadtools.com/utilities/Multimedia-Filter-Pack/Multimedia-Filter-Pack.htm).

**Using Xena with WMCap**

WMCap is a basic Windows Media program for capturing uncompressed .avi files. It is included on the Xena CD for your convenience.

There are some settings necessary to make WMCap work properly with a Xena card. The following steps explain how:

1. In the “Devices” menu, choose “Xena Video Capture” and “Xena Audio (1).”
2. Under “Options > Audio Format”, choose “48.000 kHz, 16 bit, Stereo”.
3. Under “Options > Video Capture Pin...”, choose the desired Output Size (to match the format selected in the Xena Control Panel’s Video Settings) and Color Space.
4. Select the appropriate Frame Rate (to match the format selected in the Xena Control Panel’s Video Settings). Note that a bug in WMCap prevents the Frame Rate from being displayed properly upon successive invocations of the Properties dialog. Under “Capture > Set Frame Rate...”, type the matching frame rate, or un-select the “Use Frame Rate” checkbox.

WMCap is good for verifying basic system functionality, but occasionally has problems producing smooth output video. If you can’t get smooth output video using WMCap on your system, or experience poor results after encoding an .avi file to a .wmv file, then consider using a different capture application.

Using Xena with Third-Party applications

Compatible with most Windows Media applications, XenaSD provides the following true broadcast-television formats: 720x486 interlaced at 29.97 frames per second, and 720x576 interlaced at 25 fps. For compatibility with some applications that might not support any true broadcast formats, Xena also supports the common 720x480 format at 59.94 Hz—however when operating in this format, the six bottom lines are dropped.

XenaHD supports 1920x1080 at 30 fps, 29.97 fps, 25 fps, 24 fps, 23.98 fps, and 1280x720 at 59.94 fps and 60 fps.

For each frame size and rate, Xena supports four pixel formats: two 8-bit 4:2:2 YUV formats (UYVY and YUY2), a 10-bit 4:2:2 YUV format, and RGB32. If an application does not support any of these formats, then it won’t be able to connect to the Xena card.

No third-party applications are known to use the Xena’s output capabilities. At the time of this writing, only Windows Media Player can be used to output SDI video via the Xena card.

Table 1. Third Party Applications

<table>
<thead>
<tr>
<th>Title</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaner</td>
<td>Excellent video quality can be achieved using Discreet Logic’s Cleaner to encode files captured by the Xena. You can capture an .avi file using WM Cap, and encode it with Cleaner.</td>
</tr>
<tr>
<td>Real Helix</td>
<td>Real Networks’ Helix Producer encoder is another option for capturing and encoding audio/video input from the Xena. Version 9 is compatible with the Xena boards. Helix does not have a facility for uncompressed video, and so might not be useful for HD (as there won’t be enough CPU power to encode on-the-fly).</td>
</tr>
</tbody>
</table>
Installation

Xena installation consists of the following:

1. Disconnect power from the computer where the Xena board will be installed (remove line cord).
2. Open the computer's case and locate an open PCI slot.
3. Install Xena card module.
4. Connect desired cabling to the Xena card edge connectors.
5. Apply power to the PC, install software, and then check out the Xena card, referring to the topic “Using Xena with Application Software” found in this manual.

Video and Audio Cabling

Caution: Turn off the power to your computer (and unplug for safety) before inserting or removing the board. Failure to do so will damage the board. As always, take care to install the board using proper static precautions.

Xena features fully digital SDI (CCIR-601) or HD-SDI (CCIR-709) video input/output with industry standard BNC connectors. The 15-pin D-connector and 3 BNC’s on the Xena and XenaHD boards have the following assignments starting from the top of the board:

- **XenaSD/HD**
  - Connect the video output cable to the BNC connector at the bottom (closest the PC motherboard). This cable might be connected to your VTR SDI input, which is typically labeled blue on most digital decks.
  - Connect the SDI video input cable to the middle BNC connector. This cable might be connected to the video output of your deck.
  - If desired, connect an analog ‘black’ or reference signal to the BNC closest to the audio D-connector.
  - If you need to connect to an analog tape deck or other analog equipment, you will need the appropriate A/D and D/A converters. Good quality, low-cost converters are available from AJA Video. (Visit [http://www.aja.com](http://www.aja.com) for information on the wide variety of video/audio solutions offered by AJA.)

- **XenaSD2/HD2**
  - For capture applications, the Input is normally used as the reference source. For playback applications, an analog reference signal may be supplied to the Reference In.
Video Specifications

Reference In—if desired, supply a composite analog reference signal, such as house black. Locking the board to an analog reference source, or to a digital input (setting Input 1 as the Reference Source in the Control Panel), guarantees frequency accuracy. For HD reference, use Tri-level Sync as defined in SMPTE 274m. For 1080 modes only, you may also use analog 525 or 625 “color black.”

Inputs—SDI video input: SMPTE 259M (KSD) or SMPTE 292M (KHD) SDI
Outputs—SDI video output: SMPTE 259M (KSD) or SMPTE 292M (KHD) SDI

Standard Definition converters
To work with an analog video source, use an analog-to-digital converter such as the AJA D10AD. To convert the digital output to analog, consider an AJA converter such as the D10CE.

High Definition converters
To work with an HD analog video source, use an analog-to-digital converter such as the AJA HD10A. To convert the digital output to analog, consider the AJA HD10C.

AES Audio
The Xena features 6 channels of AES/EBU digital audio on the 6 XLR connectors which break-out from the 15-pin D-type connector. Xena uses the television sample rate of 48 kHz. The Xena can be used both as an audio record/playback device in Windows Media applications and as the default system sound device.

The Xena uses standard AES/EBU digital audio XLR connectors. Connect the multi-channel audio cable (included with the Xena) to the D-connector. Then connect each of the individual XLR input or output connectors directly to a Digital Betacam, DVC Pro 50 professional deck, or any other AES/EBU digital audio equipment.

If you need to connect to monitoring devices that uses the consumer SPDIF interface on an RCA connector, you can use a low cost AES/EBU to SPDIF converter, such as those made by Canare.

If you’re connecting to an analog audio converter that requires audio word clock, the Xena provides this signal output on the RCA connector on the multi-channel audio cable.

After the audio cables are connected, select Xena as the default system sound device. In the Windows Control Panel > Sounds and Audio Devices > Audio, select “Xena Audio Device (1)” as the Default Device for both Sound Playback and Sound Recording.

Analog converters
To work with analog audio, you will need a converter. We recommend the Midiman Flying Cow from M-Audio.

Software Installation
The Installation CD contains a Setup program to guide you through installation of the Control Panel application program. The driver installation is handled separately, by the Found New Hardware Wizard or the Update Device Driver Wizard. We’ll first discuss driver installation on the following pages and then discuss Control Panel Installation.

If you’ve lost the CD or want the latest AJA software, you can also install software by downloading a .ZIP archive file from the AJA website. This is discussed later in “Downloading and Installing Software From The AJA Website.”

About the Driver
The Xena cards are Plug-and-Play compatible, and the driver installation begins automatically the first time the computer is started with the board installed.

If you are upgrading from a previous version of Xena software, please see the “Driver Upgrade” topic presented later.

The driver is compliant with Microsoft’s Kernel Streaming 2.0 architecture, for interfacing to Windows Media applications, and also supports custom applications (and Plug-ins) through AJA’s proprietary API.

**Windows Plug-and-Play Driver Installation Procedure**

After the board is installed in the computer and the computer is re-booted, Windows will detect the board and start the “Found New Hardware Wizard”. These instructions guide you through the wizard process.

![Found New Hardware Wizard](image)

---

**Driver Installation - Found New Hardware Wizard**

1. When the board is detected the Found New Hardware dialog (shown) will be displayed. Click the Next button.
Driver Installation - Please choose you search and installation option

2. In the “...search and installation options” dialog, select “Don't search. I will choose the driver to install”.

Driver Installation - Hardware Type
3. In the “Hardware Type” dialog, select “Sound, video and game controllers”.

![Found New Hardware Wizard]

**Driver Installation - Select the device driver you want to install for this hardware**

4. In the “Select the Device Driver...” dialog, select the “Have Disk...” button.
5. Select “E:\XenaDriver” (where E: is the letter of your CD-ROM drive) as the location.

![Install From Disk]

**Driver Installation - Install From Disk**

6. After selecting the disk directory containing the driver, you are brought back to the “Select the device driver you want to install for this hardware” page. Press the ‘Next’ button.
Caution: If you install the wrong driver for the model of Xena you have, you will receive a warning dialog: "Installing this device driver is not recommended because Windows cannot verify that it is compatible with your hardware..." If you receive this message, DO NOT continue installation. Stop installation and verify the type of board you are installing and then ensure you select the correct driver for it. The warning indicates that the wrong driver is being installed for the Xena board currently installed. For example, if you try to install an SD driver for an HD board, this warning may appear. This warning could also show up if you have multiple Xena boards installed, and the Device Manager selects the wrong one when installing the driver. Installing multiple Xena cards is not currently supported by the software.

Driver Update Warning—Showing Board and Driver Are Not Compatible

7. The Xena driver has not been tested for Windows Logo compatibility. Press the "Continue Anyway" button to install the driver.

Driver Installation - Windows Logo testing

Driver Upgrade Only

If you are not installing a Xena card, but merely upgrading software, you can use the “Update Device Driver Wizard”, following the same instructions as the Found New Hardware Wizard. Detailed instructions are outlined below to bring up the "Update Device Driver Wizard."

2. In the Device Manager, double-click the “AJA Xena Serial Digital Framestore” icon, or select the “AJA Xena Serial Digital Framestore” icon and choose “Properties” from the “Action” menu.
In the “AJA Xena Serial Digital Framestore Properties” dialog, select the “Driver” tab and click “Update Driver...”. From there, follow the same instructions given in the Windows Plug-and-Play Driver Installation topic presented earlier.
**Driver Update - Xena Properties**

**Xena Control Panel Installation**

The Control Panel is a Windows tray application that is started during login. When it is running, a ‘color bars’ icon appears in the corner of the taskbar. Left- or right-clicking on the icon brings up a menu of choices. The Control Panel can be used to setup the board and to set Audio/Video synchronization preferences for Windows Media. The Control Panel should always be run before any other Xena software because it initializes the board.

After installing the driver, install the Xena Control Panel by inserting the AJA Xena Installation CD into the PC’s CD-ROM drive. A Xena installation screen will be displayed with several installation options that you can select.
To begin Control Panel installation, follow these steps:

1. Click the “Install Xena... Control Panel” button that is highlighted. (The installer will grey-out buttons that do not apply.)

2. A wizard screen is displayed. Click the “Next” button to begin installation. Follow the instructions for each screen, pressing “Next” each time until you get the last screen which has a “Finish” button.
3. Click the “Finish” button to conclude Xena Control Panel Installation.

After installation, the Control Panel.exe file will be in the Startup folder (as seen in Start menu / Programs / Startup). If the install procedure was done by a user with Administrator privileges on the PC, the Control Panel will be placed in the “All Users” Startup folder. If the installation is done under an account without Administrator privileges, the Control Panel will appear only in that user’s Startup folder.

If other users also want to operate the card, they will need to add the Control Panel to their own Startup folder (or to the “All Users” Startup folder).

**Xena Tools Installation**

The AJA Xena Installer that you just used to install the Control Panel also allows you to install Xena documentation and a Windows Media Files folder that contains Windows Media Encoder configuration files. With the initial installer screen displayed, click the “Install Tools and Manuals” button to copy these files. Also installed are a set of Benchmark utilities for measuring Xena’s performance in your system.

**Install Photoshop Plug-ins**

**Note:** If you aren’t using Photoshop, you don’t need to install the plug-ins.

To install Photoshop plug-ins, you must manually copy the plug-ins from the Photoshop folder on the Xena CD to the Adobe \ Photoshop xx \ Plug-Ins directory (usually under the Programs folder). There are several subdirectories in the Plug-ins folder; the Xena plug-ins will work if placed anywhere under the “Plug-Ins” directory. Once placed in the plug-ins folder, you will be able to use the plug-ins in Adobe Photoshop from the Photoshop File menu, under the Import and Export menu items. You can now import stills from Xena as well as output images from Photoshop to Xena.

**Note:** The plug-ins also work with Adobe PhotoDeluxe.
Use of Xena with Adobe Photoshop is discussed earlier in this manual (see the topic “Using Xena with Photoshop”).

**Install AfterEffects Plug-ins**

**Note:** If you aren’t using AfterEffects, you don’t need to install the plug-ins.

To install AfterEffects plug-ins, you must manually copy the plug-ins from the AfterEffects folder on the Xena CD to the `Adobe \ AfterEffects xx \ Plug-Ins` directory. There are several subdirectories in the Plug-ins folder; the Xena plug-ins will work if placed anywhere under the “Plug-Ins” directory.

**Install PowerCG Support**

Xena supports PowerCG from Cayman Graphics. To install PowerCG support, manually copy the `PCG_HWFB.dll` from the PowerCG folder on the Xena installation CD over the old one in your PowerCG installation directory.

**WM9Capture Installation**

The Windows Media 9 Capture utility, WM9Cap, is supplied on the Xena CD. You must run the `wm9capture_setup` program from the WM9Capture folder on the CD to install WM9Cap.

**DirectX9 Installation**

If your Windows system does not have DirectX version 8.1 or later, you must install DirectX. DirectX 9.0b is included on the Xena CD. DirectX 8.1 or greater is required for the Xena board to work. (DirectX 8.1 is included with Windows XP.) DirectX 9 is highly recommended for using Xena with Windows Media applications.

The latest DirectX executable is available from the Microsoft website at [http://www.microsoft.com/windows/directx/default.aspx](http://www.microsoft.com/windows/directx/default.aspx)

To install DirectX 9.0b, you can run the `dxsetup` program in the DirectX9 folder on the Xena CD.

---

**Caution:** DirectX9 is a system component that cannot be uninstalled.

---

**Downloading and Installing Software From The AJA Website**

In addition to installing from the supplied AJA CD, you can also obtain the latest software release directly from the AJA website. Simply run a browser on your PC and enter the following web address (URL):

http://www.aja.com/support_xena.html

On the web page you’ll see a list of software archives. Find the one that matches your model of Xena and click on the link. For example:

http://www.aja.com/ajashare/xenasd5.2.zip

This will download the .ZIP archive file to your PC. Once downloaded, expand the archive using your favorite .ZIP utility (e.g. WinZip or the equivalent). The expanded archive folder contains the same files as found on the CD; to start the installer, run the “install.exe” file. To install the driver, follow the instructions given in the **Windows Plug-and-Play Driver Installation** topic presented earlier in this manual; after pressing “Have Disk...” as directed there, select the “Xena Driver” folder from the expanded archive.
Troubleshooting Installation Problems

Read the following troubleshooting topics in the event you experience problems after installation. Look for a subject discussing the problem you found. If you don’t find your problem listed here, contact the dealer where you purchased the Xena card for specific problem resolution.

Driver Has Not Loaded

You can determine that the Xena_SD.sys (or Xena_HD.sys) driver hasn’t loaded correctly by looking in the Event Viewer or Device Manager. Also, the Control Panel will dim the dialog choices if it cannot communicate with the driver.

PCI slot Compatibility

If the Xena card does not seem to be working, check whether the board is plugged into a compatible PCI slot. (See the Requirements topic presented at the beginning of this manual.) Check to see if there are two different types of PCI slots on your motherboard (32-bit / 64-bit), and try it in the other type of slot. Some motherboards may supply both 5.0 v and 3.3 v power to some slots, but not to others.

Page Table Entries

Some Windows systems (particularly under Windows 2000) don’t allocate enough resources for frame memory PCI cards. If the Xena card does not work after you have installed the board, driver, Control Panel, and then rebooted, the registry may need to be edited manually because the system did not allocate enough Page Table Entries for the driver to load correctly.

**Caution:** Editing the registry should only be attempted by persons with understanding of the registry and proper editing methods. Failure to edit the registry correctly can result in a system that will not boot or operate properly.

Before changing the Registry, take the usual precautions (backup the Registry, etc.). You will need to modify the following:

```
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory Management\SystemPages
```

It is usually 0 (which signifies that a default value is used). Usually a number like 50000 decimal is sufficient for SD boards. For HD boards, you may need 85000 pages. You will need to reboot after changing this setting.

**Note:** You will need about 20000 pages for general system use, plus the number of pages needed for each AJA board installed.

- XenaSD: 32769 pages
- XenaSD2: 32770
- XenaHD and XenaHD2: 65538 pages

Green Lines (Xena Software Used With Kona Hardware)

Some older Kona cards may exhibit green lines in the video output when used in certain PC’s. (This problem does not exist in any Xena cards.) Early Kona cards designed for the Mac G4 may not be compatible with all PC’s. If green lines consistently appear in the video, a hardware upgrade is available for these Kona cards. This upgrade will provide a more robust clock circuit, eliminating the green line problem.
Troubleshooting  
Software  
Operation  

**Firmware Initialization failure**  
Any time the Control Panel is started, hardware configuration registers are set to the values stored in the registry; but this operation can fail if the firmware initialization is not complete. Video Format, Reference Source, and Video Processing settings may need to be ‘reset’ manually. If, after a system start-up, the board is not functioning correctly, try resetting the Video Format and Reference Source.

**DMA Speed**  
If DMA speeds are slow after a cold-boot, but faster after a system re-start—then you are seeing a Xena condition that manifests itself rarely on certain PCs. On older Xena boards this condition can be caused by the board failing to auto-detect a 64-bit PCI slot. Use the “64-bit PCI slot” control in the Windows Media Page at the Xena Control Panel to force the Xena to recognize the 64-bit slot.

**Windows Media Problems and Solutions**

**Windows Media applications — No Xena device listed.** If, after Xena installation, the Windows Media application does not list Xena as an available Capture Device, the device installation may be incomplete. Try rebooting the computer to save the new device information. If the application does not process video after the Xena device has been selected, the application might not be asking for any formats supported by Xena. You may be able to change some settings in the application to make it work. First, try using the most basic applications, WMCap and SoundRecorder, to see if the Xena is indeed functioning and connected properly.

**Windows Media — Filter cannot report capture information.** If WMCap reports “Filter cannot report capture information “in the status bar (instead of the captured/dropped frame count), make sure you are running DirectX version 9.0 or better. From “Start / Run...”, open “dxdiag.” If the “DirectX Version” is 8.1, Capture filter registration will be incomplete. Other symptoms with 8.1 include: WMCap menu item “Options... / Video Capture Pin” does not bring up the Properties dialog; Windows Media Encoder can not bring up the Mixer from the “Mixer...” button in the Audio Panel; and some applications may be unable to capture video.

**Windows Media — Windows Media Player will not play a file.** The video size in the file must be 720 x 486, or 720 x 480, or 720 x 576. The pixel format (fourcc code) must be UYVY, YUV2, or RGB32. Also, Direct X version 9.0, or newer, must be installed.

**“There is a problem with your sound hardware.”.** The error message “There is a problem with your sound hardware.” may appear when attempting to access the Mixer dialog for a Xena Audio Device, if there are no volume controls enabled for that Device. See the Windows Media Audio Configuration topic earlier in this manual for the remedy to this condition.

**“This graph cannot preview!”.** WMCap gives this error message if you attempt to enable Preview while Windows Media Player is configured for output to Xena. (Please note that if you have both XenaSD and XenaHD and the Windows Media Player is configured for output to either board, then neither will be able to Preview to the PC monitor.)

**Audio configuration (embedded audio).** In the Windows Media Encoder audio configuration dialogs, changing the “Pin Line” to one of Xena’s embedded audio pairs will have no effect. To change between AES audio and Embedded Audio channels, you must use the full mixer dialog. (See “Sound Recording controls” presented earlier in this manual.)
When to Use the Reference Source Input

Setting the Reference Source to “Free Run” is intended to allow you to use the board as a stand-alone signal generator, without a reference signal. However, while in free-run mode, the frequency accuracy may not be accurate enough for some equipment, as the frequency may be +/- 50 ppm from the desired. Locking the board to a reference source, such as analog black, or a digital input, solves this problem.

For Capture mode, Reference Source must be set to “Input 1” (or “Input 2”, whichever input is being captured). The Control Panel does this automatically, and whatever application you might be using should do this also, but if not, you may need to do it manually. If a capture in your application does not occur cleanly, try resetting the Reference Source with the Control Panel.

If Your Application Drops Frames

If you notice that an application drops frames when using Xena, ensure that the disk storage system and PCI architecture has the speed and bandwidth to keep up. See the Requirements topic at the beginning of this manual, and in particular the discussions on “Disk arrays and PCI performance...”. Benchmark utilities are provided on the Xena Installation CD to measure your system’s performance capabilities.

Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>XenaSD Specification</th>
<th>XenaHD Specification</th>
<th>XenaSD2 Specification</th>
<th>XenaHD2 Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video I/O</td>
<td>SDI in/out, 2 x BNC</td>
<td>HD-SDI in/out, 2 x BNC</td>
<td>SDI in/out, Two</td>
<td>HD-SDI in/out, Two</td>
</tr>
<tr>
<td>Format:</td>
<td>10-bit or 8-bit SMPTE-259</td>
<td>10-bit or 8-bit SMPTE-292</td>
<td>Channels, 4 x BNC</td>
<td>Channels, 4 x BNC</td>
</tr>
<tr>
<td>Video Files:</td>
<td>Uncompressed 10-bit,</td>
<td>Uncompressed 10-bit,</td>
<td>Uncompressed 10-bit,</td>
<td>Uncompressed 10-bit,</td>
</tr>
<tr>
<td></td>
<td>525/59.94, 625/50</td>
<td>1080i 50/59.95/60, 1080p/psf 23.976/24/25/29.97/30</td>
<td>525/59.94, 625/50</td>
<td>1080i 50/59.95/60, 1080p/psf 23.976/24/25/29.97/30</td>
</tr>
<tr>
<td>Audio I/O:</td>
<td>6-Channel AES/EBU in/out, 20/24-bit, 48 kH internal input sample rate conversion (accepts 32-96 kHz AES/EBU inputs). 15-pin “D” Connector 6 XLR Breakout Cable (supplied)</td>
<td>6-Channel AES/EBU in/out, 20/24-bit, 48 kH internal input sample rate conversion (accepts 32-96 kHz AES/EBU inputs) 15-pin “D” Connector 6 XLR Breakout Cable (supplied)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Genlock Input:</td>
<td>BNC, Color Black, Composite Sync</td>
<td>BNC, Color Black, Tri- or Bi-Level Sync</td>
<td>BNC, Color Black, Composite Sync</td>
<td>BNC, Color Black, Tri- or Bi-Level Sync</td>
</tr>
<tr>
<td>Memory:</td>
<td>128MB</td>
<td>256MB</td>
<td>128MB</td>
<td>256MB</td>
</tr>
<tr>
<td>PCI Specification:</td>
<td>64-bit, 33 MHz, Bus Master</td>
<td>64-bit, 33 or 66 MHz, Bus Master</td>
<td>64-bit, 33 or 66 MHz, Bus Master</td>
<td>64-bit, 33 or 66 MHz, Bus Master</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>1.5 Amps @ 3.3V, 0.25 Amps @ 12V, 0.4 Amps @ 5V, Total = 10 Watts</td>
<td>XenaHD 3 Amps @ 3.3V, 0.25 Amps @ 12V, 0.25 Amps @ 5V, 14.25 Watts Total</td>
<td>XenaSD2 1.3 Amps @ 3.3V, 0.5 Amps @ 12V, 0.3 Amps @ 5V, Total = 12 Watts</td>
<td>XenaHD2 3 Amps @ 3.3V, .3 Amps @ 12V, 0 Amps @ 5V, 13.6 Watts Total</td>
</tr>
</tbody>
</table>
10-bit video 5
15-pin D-connector 7
3rd-party software 7

A
A/V Synchronization 11
AES Audio 32
AfterEffects Plug-ins 42
Application Requirements 3
Application Software 7
asynchronous audio 7
audio 1
Audio Configuration 23
audio devices 23
Audio Inputs And Outputs 7
Audio Mixer 25
Audio Record Delay 12
audio record/playback 32

B
black burst 7
Block Diagram 5

C
Cabling 31
Control Panel 7
Control Panel Installation 39
converters 32

D
data rate 5
Delay 11
digital audio 32
DirectShow-compatible 1
DirectX architecture 1
DirectX9 Installation 42
Disk arrays 4
Disk throughput 4
Dither 11
Driver 33
Driver Installation Procedure 33
Driver Upgrade 37

E
Encoder Configuration 28
Encoder configuration files 27
Encoder Performance 27

F
Features 1
Format 7

G
GenLock 7
GraphEdit 29
Green Lines 44

H
Hardware 3
HDNTV2 1
High Definition 32
house reference 7

I
I/O Connections 6
Input 1 32
Installation 31
Installation CD 32
Installer Screen 40

K
Kona boards 1

M
Microsoft applications 2

O
Output 1 32
Output to Windows Media Player Window 12
Output to Xena Board 12

P
Page Table Entries 43
PCI performance utility 3
PCI slot Compatibility 43
PCI Slot Information 3
Photoshop 3
Photoshop Plug-ins 42
Plug-and-Play compatible 33
PowerCG Support 42
Preferences 12
Processor 3
Processor requirements 28
R
RAM 3
Reference In 32
Reference Input 7
Reference Source 7
Reference Source Input 45
Requirements 2
resize filter 29

S
SCSI 4
SDI 1
SDI Input and Output 7
SMPTE 259M 1
SMPTE 292M 1
Software 2
Software Installation 32
Sound Playback 24
Sound Recorder 2
Sound Recording controls 25
Specifications 32
Specifications Table 46
Split Mode 14
Standard Definition 32
sync generator 7
synchronizing other video equipment 7

T
Test Patterns 9
Third-Party applications 30
Tools Installation 42
Troubleshooting Installation Problems 43
Troubleshooting Software 45

U
Uncompressed video 28
Using Xena with Windows Media Player 9 28

V
Vid Proc Mode 13
Video Delay 11
Video Processing Settings 13
Video Settings 7

W
WDM Streaming driver 1
Windows 2000 2
Windows Media applications 7
Windows Media Encoder 2
Windows Media Encoder 9 27
Windows Media Player 2, 28
Windows Media Player Preference settings 12
Windows Media Problems and Solutions 45
Windows Media Settings 11
Windows Media support 1
Windows XP 2
WM9Capture Installation 42
WMCap 29
WmCap 2

X
Xena Control Panel 7
Xena Models 1
XenaHD 1
XenaSD-22 1
XLR connectors 32